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Convert Network Configurations
This chapter explains how to convert from one SONET topology to another in a Cisco ONS 15600
network. For initial network turn-up, see Chapter 5, “Turn Up a Network.”

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).
1.

NTP-E179 Convert a Point-to-Point to a Linear ADM Automatically, page 12-1—Complete as
needed.

2.

NTP-E99 Convert a Point-to-Point to a Linear ADM Manually, page 12-4—Complete as needed if
the in-service topology upgrade wizard is not available or you need to back out of the wizard.

3.

NTP-E100 Convert a Point-to-Point or Linear ADM to a Two-Fiber BLSR Manually,
page 12-6—Complete as needed.

4.

NTP-E166 Convert a Two-Fiber BLSR to a Four-Fiber BLSR Automatically, page 12-8—Complete
as needed.

5.

NTP-E103 Modify a BLSR, page 12-9—Complete as needed.

NTP-E179 Convert a Point-to-Point to a Linear ADM
Automatically
Purpose

This procedure upgrades a 1+1 point-to-point configuration (two nodes)
to a linear add-drop multiplexer (ADM) (three or more nodes) without
disrupting traffic.

Tools/Equipment

Compatible hardware necessary for the upgrade (for example, ASAP
cards)
Attenuators might be needed for some applications.

Prerequisite Procedures

This procedure requires that the node to be added is reachable (has IP
connectivity with Cisco Transport Controller [CTC]). Two technicians
who can communicate with each other during the upgrade might be
needed if the PC running CTC and the ONS 15600 nodes are not at the
same location.

Required/As Needed

As needed
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Onsite/Remote

Onsite

Security Level

Provisioning or higher

Note

OC-N transmit and receive levels should be in their acceptable range as shown in the specifications for
each card in Table 2-2 on page 2-10.

Note

If overhead circuits exist on the network, an in-service topology upgrade is service-affecting. The
overhead circuits will drop traffic and have a status of PARTIAL after the upgrade is complete.

Step 1

Complete the “DLP-E26 Log into CTC” task on page 16-33 at either of the point-to-point nodes. If you
are already logged in, continue with Step 2.

Step 2

In network view, right-click the span between the two nodes where you want to add the new node. A
dialog box appears.

Step 3

Choose Upgrade Protection. A drop-down list appears.

Step 4

Choose Terminal to Linear and the first page of the wizard, Upgrade Protection: Terminal to Linear,
appears. The dialog box lists the following conditions for adding a new node:

Step 5

•

The terminal network has no critical or major alarms.

•

The node that you will add has no critical or major alarms.

•

The node has a compatible software version with that of the terminal nodes.

•

The node has four unused optical ports matching the speed of the 1+1 protection and no
communications channel has been provisioned on these four ports.

•

Fiber is available to connect the added node to the terminal nodes.

If all conditions listed in Step 4 are met, click Next.

Note

If you are attempting to add an unreachable node, you must first log into the unreachable node
using a separate CTC session and configure that node. Delete any existing protection groups as
described in the “DLP-E87 Delete a 1+1 Protection Group” task on page 16-87. Delete any
existing data communications channel (DCC) terminations as described in the “DLP-E198
Delete a Section DCC Termination” task on page 17-76 or the “DLP-E199 Delete a Line DCC
Termination” task on page 17-76.

Step 6

Enter the node host name or IP address or choose the name of the new node from the drop-down list. If
you type in the name, make sure it is identical to the actual node name. The node name is case sensitive.

Step 7

Click Next. The Select Protection Group Ports page appears (Figure 12-1).
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Figure 12-1

Selecting Protection Group Ports

Step 8

From the drop-down lists, select the working and protect ports on the new node that you want to connect
to each terminal node.

Step 9

Click Next. The Re-fiber the Protected Path dialog box appears (Figure 12-2). Follow the instructions in
the dialog box for connecting the fibers between the nodes.
Figure 12-2

Step 10

Refibering the Protect Path

When the fibers are connected properly, click Next. The Update Circuit(s) on Node-Name dialog box
appears.

Note

The Back button is not enabled in the wizard. You can click the Cancel button at this point and
click Yes if you want to cancel the Upgrade Protection procedure. If the procedure fails after you
have physically moved the fiber-optic cables, you must restore the fiber-optic cables to their
original positions and verify (through CTC) that traffic is on the working path of the nodes
before restarting the process. To check the traffic status, go to node view and click the
Maintenance > Protection tabs. In the Protection Groups area, click the 1+1 protection group.
You can see the status of the traffic in the Selected Group area.
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Step 11

Click Next. The Force Traffic to Protect Path dialog box appears, stating that it is about to force the
traffic from the working path to the protect path for the terminal nodes.

Step 12

Click Next.

Step 13

Follow each step as instructed by the wizard as it guides you through the process of refibering the
working path between nodes and forcing the traffic back to the working path. The final dialog box
informs you when you have completed the procedure of upgrading from terminal to linear protection.

Step 14

Click Finish.
Stop. You have completed this procedure.

NTP-E99 Convert a Point-to-Point to a Linear ADM Manually

Caution

Purpose

This procedure converts a 1+1 point-to-point configuration (two nodes)
to a linear ADM configuration (three or more nodes) manually, that is,
without using the in-service topology upgrade wizard. Use this
procedure if the wizard is unavailable or if you need to back out of the
wizard.

Tools/Equipment

None

Prerequisite Procedures

NTP-E33 Provision a Point-to-Point Connection, page 5-3

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

Provisioning or higher

This procedure is service-affecting.

Note

Optical transmit and receive levels should be in their acceptable range as shown in the specifications
section for each card in Table 2-2 on page 2-10.

Note

In a point-to-point configuration, two OC-N cards are connected to two OC-N cards on a second node.

Step 1

Complete the “DLP-E26 Log into CTC” task on page 16-33 at either of the point-to-point nodes. If you
are already logged in, continue with Step 2.

Step 2

Complete the “DLP-E137 Check the Network for Alarms and Conditions” task on page 17-30.

Step 3

Log into the node that will be added to the point-to-point configuration (the new node).

Note

If you are attempting to add an unreachable node you must first log in to the unreachable node
using a separate CTC session and configure that node. Delete any existing protection groups as
described in the “DLP-E87 Delete a 1+1 Protection Group” task on page 16-87. Delete any
existing DCC terminations as described in the “DLP-E198 Delete a Section DCC Termination”
task on page 17-76 or the “DLP-E199 Delete a Line DCC Termination” task on page 17-76.
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Step 4

Verify that the new node has four OC-N ports at the same rate as the point-to-point node.

Step 5

Complete the “NTP-E32 Verify Node Turn-Up” procedure on page 5-2 for the new node.

Step 6

Physically connect the fibers between the point-to-point node you are logged into and the new node.

Step 7

On the new node, create a 1+1 protection group for the OC-N cards that will connect to the point-to-point
node. See the “NTP-E26 Create a 1+1 Protection Group” procedure on page 4-11 for instructions.

Step 8

Complete the “DLP-E114 Provision Section DCC Terminations” task on page 17-13 for the working
OC-N ports in the new node that will connect to the linear ADM network. (Alternatively, if additional
bandwidth is needed for CTC management, complete the “DLP-E189 Provision Line DCC
Terminations” task on page 17-70.) Make sure to set the port state in the Create SDCC Termination
dialog box to IS.

Note

DCC failure alarms appear until you create DCC terminations in the point-to-point node during
Step 13.

Step 9

From the View menu, choose Go To Network View.

Step 10

Double-click the point-to-point node that will connect to the other side of the new node.

Step 11

Ensure that this point-to-point node has OC-N cards installed that can connect to the new node.

Step 12

Create a 1+1 protection group for the OC-N ports that will connect to the new node. See the “NTP-E26
Create a 1+1 Protection Group” procedure on page 4-11 for instructions.

Step 13

Create DCC terminations on the working OC-N port that will connect to the new node. See the
“DLP-E114 Provision Section DCC Terminations” task on page 17-13 or the “DLP-E189 Provision Line
DCC Terminations” task on page 17-70. In the Create SDCC Termination dialog box, set the port state
to IS.

Step 14

From the View menu, choose Go To Network View.

Step 15

Double-click the new node.

Step 16

Complete the “NTP-E24 Set Up Timing” procedure on page 4-10 for the new node. If the new node is
using line timing, make the working OC-N card the timing source.

Step 17

Display the network view to verify that the newly created linear ADM configuration is correct. A single
green span line should appear between each linear node.

Step 18

Click the Alarms tab.

Step 19

a.

Verify that the alarm filter is not on. See the “DLP-E157 Disable Alarm Filtering” task on
page 17-47 for instructions.

b.

Verify that no unexplained alarms appear on the network. If unexplained alarms appear, resolve
them before continuing. Refer to the Cisco ONS 15600 Troubleshooting Guide.

Repeat the procedure for each node that you want to add to the linear ADM. To create circuits, see
Chapter 6, “Create Circuits.”
Stop. You have completed this procedure.
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NTP-E100 Convert a Point-to-Point or Linear ADM to a Two-Fiber
BLSR Manually

Caution

Note

Purpose

This procedure upgrades a point-to-point configuration to a two-fiber
BLSR.

Tools/Equipment

None

Prerequisite Procedures

NTP-E33 Provision a Point-to-Point Connection, page 5-3

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

Provisioning or higher

This procedure is potentially service-affecting.

Optical transmit and receive levels should be in their acceptable range as shown in Table 2-2 on
page 2-10.

Step 1

Complete the “DLP-E26 Log into CTC” task on page 16-33 at one of the nodes that you want to convert
from a point-to-point or ADM to a bidirectional line switched ring (BLSR). If you are already logged in,
continue with Step 2.

Step 2

Complete the “DLP-E137 Check the Network for Alarms and Conditions” task on page 17-30.

Step 3

Right-click a span adjacent to the node you are logged into.

Step 4

From the shortcut menu, choose Circuits. The Circuits on Span window appears.

Step 5

Verify that the total number of active synchronous transport signal (STS) circuits does not exceed
50 percent of the span bandwidth. In the Circuits column there is a block titled “Unused.” This number
should exceed 50 percent of the span bandwidth.

Note

Caution

If the span is an OC-48, no more than 24 STSs can be provisioned on the span. If the span is an
OC-192, no more than 96 STSs can be provisioned on the span.

If the first half of the capacity is exceeded, this procedure cannot be completed. Bandwidth must be
50 percent unassigned to convert to a BLSR. Refer to local procedures for relocating circuits if these
requirements are not met.

Step 6

Repeat Steps 3 through 5 at each node in the point-to-point or linear ADM that you will convert to the
BLSR. If all nodes comply with Step 5, continue with Step 7.

Step 7

Complete the “DLP-E108 Verify that a 1+1 Working Port is Active” task on page 17-8 for every 1+1
protection group that supports a span in the point-to-point or linear ADM network.

Step 8

Complete the “DLP-E87 Delete a 1+1 Protection Group” task on page 16-87 at each node that supports
the point-to-point or linear ADM span.

Step 9

Complete the “DLP-E115 Change the Service State for a Port” task on page 17-15 to put the protect ports
out of service at each node that supports the point-to-point or linear ADM span.

Cisco ONS 15600 Procedure Guide, R9.0

12-6

78-18396-01

Chapter 12 Convert Network Configurations
NTP- E100 Convert a Point-to-Point or Linear ADM to a Two-Fiber BLSR Manually

Step 10

Figure 12-3

(Linear ADM only) Physically remove the protect fibers from all nodes in the linear ADM. For example,
in Figure 12-3 you could remove the fiber running from Node 2/Slot 13/Port 1 to Node 3/Slot 13/Port 1.

Linear ADM to BLSR Conversion
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Slot 12, Port 3
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Slot 12, Port 3
(West)
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96439
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(West)

ONS 15600
Node 3

Step 11

Create the ring by connecting the protect fiber from one end node to the protect port on the other end
node. For example, the fiber between Node 1/Slot 1/Port 5 and Node 2/Slot 1/Port 5 (Figure 12-3) can
be rerouted to connect Node 1/Slot 1/Port 5 to Node 3/Slot 13/Port 1.

Note

If you need to physically remove any OC-N cards, do so now. In this example, cards in
Node 2/Slots 1 and 13 can be removed. See the “NTP-E14 Remove and Replace a Card”
procedure on page 2-8.

Step 12

In network view, click the Circuits tabs and complete the “DLP-E265 Export CTC Data” task on
page 18-76 to save the circuit data to a file on your hard drive.

Step 13

Complete the “DLP-E114 Provision Section DCC Terminations” task on page 17-13 at the end nodes to
provision the slot in each node that is not already in the SDCC Terminations list.

Step 14

For circuits provisioned on an STS that is now part of the protection bandwidth (STSs 25 to 48 for an
OC-48 BLSR, and STSs 97 to 192 for an OC-192 BLSR), delete and recreate each circuit:

Note

Step 15

Deleting circuits is service-affecting.

a.

Complete the “DLP-E163 Delete Circuits” task on page 17-50 for one circuit.

b.

Create the circuit on STSs 1 to 24 for an OC-48 BLSR, or 1 to 96 for an OC-192 BLSR on the fiber
that served as the protect fiber in the linear ADM. See the “NTP-E161 Create a Manually Routed
Optical Circuit” procedure on page 6-9 for instructions.

c.

Repeat Steps a and b for each circuit residing on a BLSR protect STS.

Complete the “NTP-E164 Create a BLSR” procedure on page 5-9 to put the nodes into a BLSR.
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Stop. You have completed this procedure.

NTP-E166 Convert a Two-Fiber BLSR to a Four-Fiber BLSR
Automatically
Purpose

This procedure upgrades an OC-48 or OC-192 two-fiber BLSR to a
four-fiber BLSR without disrupting traffic. The conversion will be
easier if the same east and west configuration is used on all nodes being
upgraded.

Tools/Equipment

None

Prerequisite Procedures

NTP-E164 Create a BLSR, page 5-9

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

Provisioning or higher

Note

BLSR dual-ring interconnect (DRI) configurations do not support in-service topology upgrades.

Note

Span upgrades are not supported.

Note

Two card and four card four-fiber BLSR configurations are supported. East and west ports must be
configured on separate cards; however, working and protect ports can be on the same card or separate
cards. The following modes are supported on separate cards: East-Working, East-Protect, West-Working,
and West-Protect. The following modes are supported on the same card: East-Working, and East-Protect
on card 1, and West-Working, West-Protect on card 2.

Note

BLSR protection channel access (PCA) circuits, if present, will remain in their existing STSs. Therefore,
they will be located on the working path of the four-fiber BLSR and will have full BLSR protection. To
route PCA circuits on protection channels in the four-fiber BLSR, delete and recreate the circuits after
the upgrade. For example, if you upgrade a two-fiber OC-48 BLSR to four-fiber, PCA circuits on the
protection STSs (STSs 25 to 48) in the two-fiber BLSR will remain in their existing STSs, which are
working STSs in the four-fiber BLSR. Deleting and recreating the OC-48 PCA circuits moves the
circuits to STSs 1 to 24 in the protect bandwidth of the four-fiber BLSR. To delete circuits, see the
“DLP-E163 Delete Circuits” task on page 17-50. To create circuits, see Chapter 6, “Create Circuits.”

Note

Before beginning this procedure, optical transmit and receive levels should be in their acceptable range
as shown in Table 2-2 on page 2-10.

Step 1

Complete the “DLP-E26 Log into CTC” task on page 16-33 at one of the two-fiber nodes that you want
to convert.
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Step 2

Complete the “DLP-E137 Check the Network for Alarms and Conditions” task on page 17-30.

Step 3

Complete the “NTP-E11 Install the OC-N Cards” procedure on page 2-4 or the “NTP-E183 Install the
ASAP Card” procedure on page 2-6 to install the additional OC-48, OC-192, or ASAP cards at each
two-fiber BLSR node. The newly installed OC-N cards or ASAP card ports must have the same port rate
as the two-fiber BLSR.

Step 4

Connect the fiber to the new ports. Use the same east-west connection scheme that was used to create
the two-fiber connections. See the “DLP-E234 Install Fiber-Optic Cables for BLSR Configurations” task
on page 18-42.

Step 5

Complete the “DLP-E115 Change the Service State for a Port” task on page 17-15 to put in service the
new OC-N ports.

Step 6

Test the new fiber connections using procedures standard for your site.

Step 7

Convert the BLSR:
a.

Display the network view and click the Provisioning > BLSR tabs.

b.

Choose the two-fiber BLSR you want to convert and then click the Upgrade to 4 Fiber button.

c.

In the Upgrade BLSR dialog box, set the amount of time that will pass before the traffic reverts to
the original working path after the condition that caused the switch has been resolved. The default
is 5 minutes.

d.

Click Next.

e.

Assign the east and west protection ports:

f.

•

West Protect—Select the west BLSR port that will connect to the west protect fiber from the
drop-down list.

•

East Protect—Select the east BLSR port that will connect to the east protect fiber from the
drop-down list.

Click Finish.

The fibers that were divided into working and protect bandwidths for the two-fiber BLSR are now fully
allocated for working BLSR traffic.
Step 8

Step 9

Click the Alarms tab.
a.

Verify that the alarm filter is not on. See the “DLP-E157 Disable Alarm Filtering” task on
page 17-47 as necessary.

b.

Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve
them before continuing. Refer to the Cisco ONS 15600 Troubleshooting Guide for procedures.

Complete the “NTP-E165 Four-Fiber BLSR Acceptance Test” procedure on page 5-11.
Stop. You have completed this procedure.

NTP-E103 Modify a BLSR
Purpose

This procedure changes a BLSR ring ID, node ID, or ring and span
reversion times.

Tools/Equipment

None

Prerequisite Procedures NTP-E164 Create a BLSR, page 5-9
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Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-E26 Log into CTC” task on page 16-33 at a node in the BLSR you want to modify.
If you are already logged in, continue with Step 2.

Step 2

Check the BLSR for outstanding alarms and conditions. See the “DLP-E137 Check the Network for
Alarms and Conditions” task on page 17-30 for instructions.

Some or all of the following alarms appear during BLSR setup: E-W-MISMATCH,
RING-MISMATCH, APSC-IMP, APSCDFLTK, and BLSROSYNC. The alarms clear after you
configure all the nodes in the BLSR. For definitions of these alarms, refer to the
Cisco ONS 15600 Troubleshooting Guide.

Note

Step 3

To change the BLSR ring ID or the ring or span reversion times, complete the following steps. If you
want to change a node ID, continue with Step 4.
a.

In network view, click the Provisioning > BLSR tabs.

b.

Click the BLSR that you want to modify and click Edit.

c.

In the BLSR window, change any of the following:

d.

•

Ring ID—If needed, change the BLSR ring ID (a BLSR ring ID is a 6-character string that
includes letters and numbers). Do not choose an ID that is already assigned to another BLSR.

•

Reversion time—If needed, change the amount of time that will pass before the traffic reverts
to the original working path after a ring switch.

Click Apply.

If you changed the ring ID, the BLSR window closes automatically. If you only changed a reversion time,
close the window by choosing Close from the File menu.
Step 4

Step 5

To change a BLSR node ID, complete the following steps; otherwise, continue with Step 5.
a.

On the network map, double-click the node with the node ID you want to change.

b.

Click the Provisioning > BLSR tabs.

c.

Choose a Node ID number. Do not choose a number already assigned to another node in the same
BLSR.

d.

Click Apply.

Verify the following:
•

A green span line appears between all BLSR nodes.

•

All E-W-MISMATCH, RING-MISMATCH, APSC-IMP, APSCDFLTK, BLSROSYNC, and
APSCNMIS alarms are cleared.

Note

For definitions of these alarms, refer to the Cisco ONS 15600 Troubleshooting Guide.

Stop. You have completed this procedure.

Cisco ONS 15600 Procedure Guide, R9.0

12-10

78-18396-01

